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Surpac 2021

Enhancements

Configuration

o Restructuring of Surpac menus

The following changes have been made to the Surpac View and Database menus, which you can
use to manage Sections and Viewing planes:

o o o o o o o o o

In the Database menu, the Sections menu has been renamed Grade Calculation. This
new sub-menu contains two options: Digitised segment grade and Digitised string grade.
In the View menu, the options in the Viewing planes sub-menu have been renamed:
SLICING PLANES is now the Create graphical sections option
VIEWING PLANES BACKWARD is now the Previous section option
VIEWING PLANES FORWARD is now the Next section option
REVERSE VIEW is now the Reverse view direction option
ZOOM SECTION is now the Zoom plane option
SAVE DH SECTIONS TO STRINGS is now the Save sections to string files option
LAST SECTION is now the Restore last section option
OFF SECTION DRILLHOLE STYLES is now the Off section drillholes styles option
DELETE CUTTING PLANES is now the Remove viewing / cutting planes option

Now, when sections are not loaded, the warning message Please select a plane is displayed in the
Message window.

o Lower values permitted in Max. frame distance field (View along a string form)

You can now set values as low as 0.001 in the Max. frame distance field (on the View > Data view
options > View along a string > View along a string form). Smaller values improve clarity of strings
viewed in Graphics, by increasing the number of frames.

o New DSLS-compatible SCL commands and sub-functions

The following SCL commands and sub-functions are now compatible with DSLS:

o

o

SCL commands:

scIDSLSIdentifierld: Returns the DSLS Identifier ID (Computer ID).

sclisRoleEnabled: Checks if any roles are active with the license. It returns 1 if a role is
enabled and 0 if the role is disabled.

Sub-function of SclLicenseManager:

getDslisldentifierCode: It returns the DSLS Identifier ID. The functionality is the same as
command SclDSLSlIdentifierld.

isRoleEnabled: Checks if any roles are active with the license. This sub-function works
same as command ScllsRoleEnabled.

e Warning messages for connecting to DSLS licensing remotely were not displayed

When you use Surpac remotely and try to update the DSLS licensing, a warning message is now
displayed in the Message window.
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Geology

e Enhancements to Structural suite module
The following enhancements have been made to the Structural suite module:

+ By default, theOpen file in Dips checkbox is cleared on both the Export selected data to
Rocscience Dips and Export data inside a solid to Rocscience Dips forms.

» The Export to Dips form does not appear unless 3 or more points have been digitized.

* You can now enter up to three decimal values in the Description field values column, on
the Edit description values form.

DTM information retained by MESH CONDITIONING REMOVE SMALL TRIANGLES
function
If the output file is saved as a new layer, the MESH CONDITIONING REMOVE SMALL TRIANGLES
function now retains .dtm file information:

» .dtm Description values
» .dtm Trisolation name
« .dtm Triobject name

o Use the Refresh button to apply color range changes

You can now apply changes to color range values by using the Refresh button, in the Colour
Transition section on the BLOCK COLOURS form.

® Create a solid from block model metadata

You can now use the new BM CODE SOLIDS function to create a solid, using metadata from a
block model opened in the Graphics window.

o Classifying large solids needed long processing times

Now, processing and output are faster when classifying large SDM files with the CLASSIFY SDM
function.

o Modifying an SDM attribute function caused issues
The SDM ATTRIBUTES and SDM FILE ATTRIBUTES functions now support:

» TCL script recording.
* Real values validation, in the decimal value field.

Tools

o STRINGS OVER DTM function now validates SDM files prior to use

The STRINGS OVER DTM function now validates an .sdm file before you perform an operation. If
the .sdm file does not contain any triangles, then a warning message is displayed in the Message
box.

o Delete .sdm attribute metadata with a new SCL command

You can use the new SciDeleteAttribute function to delete the attribute metadata from any .sdm
file.

o New SCL functions to set and get SDM file attribute information
You can use new SCL functions to set and get SDM file attribute value type and number of
decimals:

+ SclAddAttributeValuesAndDetails function: sets the attribute value type and the number of
decimals
+ SclGetAttributeDetails function: gets the attribute value type and the number of decimals
These new SCL commands will not work with prior versions of Surpac.
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o Setting an upper limit for the SDM classification output gave incorrect results

Upper limit values are now correctly defined, and correct defined range is shown in the output, when
you classify a .sdm file and enter the upper limit in the To column (in the Output section on the
Solids > Solids tools > Classify SDM > SDM classification form).

e Update SDM file user attributes with the new SDM ATTRIBUTES function

You can use the new SDM ATTRIBUTES function to update SDM file user attributes, and to display
the SDM in Graphics.

o Choose and apply .ssi styles file from the OPEN FILE form
You can now choose and apply a .ssi styles file from the Open file form. Access the Open file form
from the OPEN FILE function or the File > Open > String/DTM command.
The styles file can be specified in the Drawing styles file textbox under the Data loading options
segment.

o Enhancements in the Properties form for Select tool
The following enhancements have been made to the Select tool:

» On the Properties form, the format is now consistent for all value fields
» The label Triobject has been renamed as Object on the Properties form.

o Save attribute information in the SDM

You can now save linked block model attributes in an SDM file. When you select the Save
attributes to SDM checkbox on the Block model report form, the SDM file is updated using attribute
information you select from the table.

Engineering

o Export metadata for solid volume reports in tabular format

For all solid volume reports, you can now export metadata of trisolations to a table. The metadata is
downloaded in a .csv file format.

Miscellaneous

o Select dates to take DSLS licenses offline

Use the new date-picker field to select and validate the dates to take DSLS licenses offline.
Surveying

o Updated version of Geocentric Datum of Australia

You can update Surpac's projection for Australia with Geocentric Datum of Australia 2020
(GDA2020). To apply GDA2020 in Surpac, use either the File tools > Transformations > Lat/Long
to traverse mercator or Traverse mercator to lat/long function in the TM Map list.

Issues Fixed
Configuration

o Tool-tips for GUIDO buttons were not displayed

Now, on all Surpac forms, you can display GUIDO button tool tips by hovering your cursor over
them.

o Points and segments below a block model could not be selected

Use the SEGMENT MOVE function to select or move the points and segments displayed below a
block model.
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o Updated software in Surpac
The following software has been updated:

* The VS2017 for the Surpac build compiler.
* Newer versions of Teigha, CATPolyhedralOper, GDAL, and Boost libraries are now
integrated into Surpac.

o No warning message when updating license without a server connection

A warning message is now displayed in the Message window if you use the Update License (UL)
command while the server connection is lost. The message prompts you to save your work before
the license is revoked.

Selecting direction of maximum continuity on Variogram map displayed old direction

footprints
When you set a new angle of continuity direction for the variogram map, the variogram map now
displays only the latest selected direction footprint (instead of all older footprints).

You can set the new angle of continuity for the variogram map on one of the following forms:

« Enter direction of maximum continuity form under Select direction of maximum continuity
menu on the Variogram map window
 Enter direction of maximum continuity form under Select direction of maximum continuity
menu on the Indicator Variogram map window.
Dassault Systémes licensing form title incorrectly displayed when system local set to
Russian
Now, when the system locale is set to Russian, the Dassault Systemes licensing form title
displays correctly .

o Loading invalid .lic or .licz license files caused Surpac to exit unexpectedly

Surpac no longer exits when you load an invalid .lic or .licz file as a tokens.ssi file. Surpac runs a
validation check, and notifies you if the file contents are not valid.

o Network license could be acquired from another server when role taken offline
DSLS has the following functionality improvements:

* Now, you cannot take a role offline and simultaneously use both the offline license and a
network/nodelock license.

« If the offline role's server is unavailable, the Return online button is disabled until the server
is online.

* When you take a license offline, you will not be able to take any other network licenses offline
until the first offline license is returned.

o Erasing a single triangle did not refresh the static model

Updated objects now display correctly after you erase a single triangle, regardless of whether the
static model has been set as the default setting.

o Files containing Turkish characters did not open

You can now open file names containing Turkish characters, if you are using Turkish locale.

File operations cause unexpected exit when Surpac installed on Windows 10 version
2004

When installed on Windows 10 version 2004, Surpac no longer exits unexpectedly when you run
basic file operations in the navigator window.

e Editing database styles with the SQL ODBC connector displayed incorrect results

When editing drillhole styles while using the SQL ODBC connector, drillhole styles now display
correctly and are no longer corrupted.
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o Some field contents in various Surpac forms were displayed in bold format

The content in all Surpac form fields are now displayed in the correct font.

o Some titles in the Compositing Options form were displayed incorrectly

When you use the COMPOSITING OPTIONS function, on the Composite fields and Display
options tab, column names in both Composite fields and Composite field display options tables
are now displayed correctly.

Tools

o Using AUTOPLOT function more than once on .dtm files caused display issues

Now, when you use the AUTOPLOT function to plot any .dtm file more than once, the plotting band
is displayed correctly in Graphics and the DTM edges are not activated.

o TCL scripts failed to fill Numeric range for a form for BM VOL TON REPORT function

Now, when you use the BM VOL TON REPORT function, the TCL scripts successfully fill the
Numeric range for Grouping attributes in Define string groups form.

o OBJ files containing spaces were not loading

You can now load an OBJ file that references to material files that contain spaces.

o Style information for SDM files were not retained properly

Now, when you use the STYLES STRING function for .sdm files, previously used string style values
are retained.

o Saving large SDM files as DTM files caused Surpac to exit immediately

Surpac can now load and save large SDM files as a DTM file, which can contain lines longer than
1024 characters.

o Files were saved in an incorrect format for SDM plugin preference

Output files are now generated in correct format, when you use the SAVE SECTION TO STRING
FILE and SAVE PLANE GROUP TO STRING FILES functions to set .sdm as your default file
extension.
Using certain plotting folder and setting parameters with the PROCESS MAP function
caused Surpac to exit unexpectedly
Surpac no longer exits unexpectedly when you open the app with certain .ssi plotting folders, and
then use the PROCESS MAP function to set parameters.

o SclGetAttributeDetails displayed an informational message as an output

Now, when you use the SclGetAttributeDetails command, an output list suitable for parsing is
generated and an information message is no longer displayed.

e SDM file formats were not supported for the SciISwaSaveDtmFile function

Now, when you use the SclSwaSaveDtmFile function, you can use the SDM file format for the
output.

o The Move tool did not function properly

When using the Move tool to pan through a segment, you can now select the plane indicator and
the move tool operates properly along the selected plane.

Engineering

o Expanding a segment by berm width changed the ramp width in Pit Design

When you use the EXPAND SEGMENT BY BERM WIDTH function, you can now use the new Keep
ramp width constant checkbox to maintain the ramp width as a constant while expanding a string
or a segment by berm width.

o Adding more than 10 rows on the SDM Classification form displayed an error message

The SDM classification form now displays more than 10 rows, when you use the CLASSIFY SDM
function to classify an SDM containing more than 10 rows of attributes.
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Geology

e Redundant points displayed after removing small triangles

Now, when using the MESH CONDITIONING REMOVE SMALL TRIANGLES function to remove
small triangles from a .dtm file, the redundant points are removed before output is displayed in
Graphics.

Recalculating point cloud deviation displayed incorrect deviation mesh

Deviation mesh is now correctly displayed in Graphics, when using the CLOUD DEVIATION
function to recalculate point cloud deviation on the Point
Cloud Deviation Analysis form.

Incorrect import report generated when importing data in new database

Correct import reports are now generated when you import data into a new database, using the
Import Data option in the Database > Database > Open/New form.

Triangulate shape tool's Triobject field only editable if New triobject checkbox cleared

Now, when using the the Tool properties panel in the TRIANGULATE SHAPE TOOL, you can only
edit the Triobject field if the New triobject checkbox is cleared.

Surpac no longer exits unexpectedly when you delete some block model attributes,
then edit remaining attributes
Surpac no longer exits unexpectedly if you delete some block model attributes, then try to edit the
remaining attributes.

Cutoff values now refreshed in secondary map variogram charts

Cutoff values are now refreshed and correctly displayed in secondary map variogram charts, after
changing indicator cutoffs in the IK Variogram modelling window, on the Indicator variogram map
calculation form.

IK Variogram Modelling window no longer exits when switching between variograms

The IK Variogram Modelling window no longer exits unexpectedly when you switch between
primary and secondary variogram maps.

Surpac no longer exits when opening large files
Surpac no longer exits unexpectedly when you open large files.

Corrected Point cloud classification label

The first Classification name has been renamed to Never classified, on the Solid > Mesh tools >
Point cloud classification > Classifications list form.

Correct attribute color range now displayed

When saving a style file with an attribute color range, using the BM GRAPHICS ATTRIBUTE
COLOUR function, correct values are now displayed in the Ranges for colour selection field.

Using the TRIANGLE DELETE function now longer displays incorrect results

Correct data is now displayed in the Graphics window when you use the TRIANGLE DELETE
function, including when the static model option is selected.

Correct data in collar table now displayed when using ODBC to connect database
When you connect to the Surpac database using ODBC, correct data is now displayed in all columns
of the Collar table. The issues with the float, date, and integer types have now been resolved.
Warning message no longer displayed when saving multiple opened and modified
SDMs

Now, when you open multiple SDMs in a single layer, delete some points, and save them again, no
warning message is displayed when the output file is saved.
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o Block Model attribute lists no longer empty on INIT STOPE and STOPE SLICER forms

Now, for both INIT STOPE and the STOPE SLICER functions, attributes for linked block models are
now correctly displayed in the Attribute list under the Block Model tab.

o Error message no longer displayed when using SOLID SLICER function

Now, no error message is displayed when opening the Solid slicer form.

Using the BM CODE SOLIDS function no longer results in faulty aggregate values

Correct aggregate values are now generated and displayed when you select a value from the
ore/rock type attribute for classification menu, on the Code solid from block model form, in the
BM CODE SOLIDS function.

Correct styles information now displayed when saving a string file as DXF or DWG

Correct styles information is now displayed for all string numbers in a string file, when saving as
either a DXF or DWG file.

Object name not functional, though mandatory in Classify SDM

» Object name is not mandatory. Users can leave that blank.
» The object name is functional now. The object's name saves inside sdm/dtm file.

Informing user if input geometry is invalid

User would be informed if input SDM of DTM contains invalid geometry data.
Miscellaneous

o Turn off automatic translation for all GUIDO form fields

The -no_mit switch now switches off automatic translation for all GUIDO form fields and controls.

o Appended plots now displayed correctly
Now, plots appended on the Plotting window are displayed correctly.

o DSLS update license forms now use consistent themes
The Surpac Licensing Server and Dassault Systemes Licesing forms are now themed consistently
for all light and dark display modes.

° Move tool now functions correctly when moving a digitized segment on the coordinate
axis
Now, when you hover over the coordinate axis of a digitized segment, the axis is highlighted in
yellow, and you can drag the point to move the segment along the coordinate axis.
e Upgrading to HOOPS version 2410 caused unstable Graphics performance

The HOOPS library has been reverted to version 2210 for better performance and stability of
operations in the Graphics window.
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